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Introduction 
Welcome to Robert’s Rules of Order Newly Revised on 
CD-ROM using Folio Views®. This guide is designed to 
help you get started with Folio Views (the search-and-
retrieval program you will use to access Robert’s Rules of 
Order Newly Revised) as quickly as possible. The Folio 
Views version of Robert’s Rules of Order Newly Revised 
(known as a Folio infobase) is a full-featured information 
database which allows you to browse, search, annotate, 
customize, print, and copy information to your word 
processor. 

This Quick Reference Guide will lead you through the 
installation process and acquaint you with the basic 
functions of Folio Views. The guide is not comprehensive; 
it is intended to show you the relevant major features of 
Folio. For more detailed information on any of the 
features mentioned in this guide, please open the Help 
Infobase (see inset on this page). After reading this guide, 
you may also want to begin browsing the Help Infobase by selecting the Help menu and then selecting 
Overview. 

Technical Support 
If you need additional assistance with the Robert’s Rules of Order Newly Revised CD-ROM, please 
contact American Legal Publishing Corporation by telephone at (800) 445-5588 or by e-mail at 
techsupport@amlegal.com. Technical support is available between 8:30 a.m. and 5:00 p.m., Eastern 
Time, Monday through Friday. 

About Folio Views® 
Folio Views is a full-text search-and-retrieval program that offers instant access to information. With 
Folio Views you can search for words, phrases, rule numbers – anything you want! Folio provides an 
easy-to-use electronic table of contents and hypertext linking capabilities to allow you to browse and 
navigate information. Folio also allows you to customize or personalize information with electronic 
notes, bookmarks, and highlighters. 

  

 
The complete Help Infobase 

is available from all 
windows, dialog boxes, and 
menus in Folio Views®. To 
view it, press F1 when the 
cursor is in any window, 
while any dialog box is 

open, or while any menu 
item is highlighted. 

mailto:techsupport@amlegal.com
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Included in This Release 
The product disk contains the following: 

• Installation setup files 
• “User Guide” folder containing this guide 
• “Ancillary Materials” folder containing copies of the bonus ancillary material described below 

After the product is installed, the following resources will be available within the Folio Views software: 

• Robert’s Rules of Order Newly Revised, 12th Edition.  
 This is the main infobase; it provides links to all the other resources as well. 

• Robert’s Rules of Order Newly Revised In Brief, 3rd Edition 
 Full text of the In Brief book, with hyperlinked references to the 12th Edition 

• Bonus ancillary material, in PDF and Folio Views formats: 
o Forms - Motion, Roll Call, Meeting Notice (9 pages) 

Motion form and instructions, step-by-step summary of roll-call voting procedures, roll-
call vote form with example, and forms for regular-meeting and special-meeting notices 

o Timekeepers’ Guide (17 pages) 
Explanation of timekeepers’ tasks and related rules, forms, checklists, and time cards 

o Ballot Voting (15 pages) 
Reviews and summaries of ballot-related rules plus checklists for conducting and tallying 
ballot votes, sample ballots, and Tellers’ Report forms with examples 

o Understanding Secondary Amendments (11 pages) 
Description of how to use secondary amendments and the basic rules governing them, 
presented in the style of the In Brief book 

o Summary of Rules Governing Preference in Recognition (4 pages) 
Abbreviated quick-reference list of who is entitled to claim preference in recognition 
when more than one member seeks to obtain the floor, plus table of motions which are 
in order when another has the floor 

o Tellers’ Report Form - Election (Interactive PDF) 
(PDF only) Open this in Adobe Acrobat or Adobe Acrobat Reader to create a Tellers’ 
Report by listing the candidates and number of votes received by each. The number of 
votes cast and the number required for a majority will be calculated automatically. 

If you wish to have access to the PDF resources without opening the Robert’s Rules of Order Newly 
Revised program, you can use Windows to copy the “Ancillary Materials” and “User Guide” folders from 
the installation disk to a local drive on your PC. Note: These files are part of the CD-ROM edition and may 
not be distributed for use by others. 
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Installation 
To install this product, the user must be logged on to Windows from an Administrator account or use 
“Run as Administrator” when installing. You may be prompted to allow the installation of required 
Microsoft Visual C++ packages before the rest of the setup begins. When prompted, click “Install” to 
complete this step. 
 
Single-User Installation 
1. Insert the product disk into the appropriate drive or port. Depending on your computer’s 
configuration, the setup program may begin automatically and you can continue with Step 2. If it 
doesn’t, use your computer to find and run the setup.exe program by doing any of the following: 

• If you know the drive letter of the installation disk, open D:\setup.exe (where D: is the drive 
letter) by typing into the Windows search box near the Start button (or on the Start button 
menu) or using the Windows Run command (press  + R)*.  

• The installation-drive folder may have already opened when the disk was inserted; if not, open 
it from File Explorer (or Windows Explorer) or the “This PC” (or “Computer”) window. Then 
open the setup.exe icon. Note: There is more than one icon with the name “setup”. Be sure to 
choose the one with the “.exe” extension. If file name extensions are hidden, choose the one 
with the InstallScript icon (see figure). 

 

2. On the License Agreement dialog box, please read and accept the terms of the license agreement. 
3. On the Setup Type dialog box, choose “Single User Install” from the list. 
4. On the Choose Destination Location dialog box, confirm the default folder or press “Browse” to 

specify a different one. If installing to a folder with other contents, be sure to specify a subfolder, 
such as \rrules12, as the destination. 
• The default folder is set to “C:\rrules12”. 

5. On the Select Program Folder dialog box, you may change the program folder name. 
6. Once the installation is complete, access Robert’s Rules of Order Newly Revised 12th Edition 

through the desktop icon that is created or from the list on the Start button menu. 
 
Network Installation 
Part I – Initial File Placement 
1–2. Do steps 1–2 of the Single-User Installation instructions (above). 
3. On the Setup Type dialog box, choose “Network Install” from the list. 

 

 

* The “+” notation in keyboard-shortcut instructions means to press and hold the first key(s) while pressing the last 
key. 
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4. On the Choose Destination Location dialog box, press “Browse” to designate a network drive and 
folder as a destination for the shared files.  
• Once you click the “Next” button, Folio Views program files will be installed to the specified 

network folder. 
 
Part II – End User Creation 
1. From the desktop of each end user, run the setup.exe program in the folder entered in Step 4 of 

the Initial File Placement instructions above. 
2. Follow the on-screen instructions to install the system files to each workstation computer. On the 

Choose Destination Location screen, confirm the default folder or press “Browse” to specify a 
different one. 

• Computers with a 64-bit version of Windows should install as a subfolder under the “Program 
Files (x86)” folder 

3. Once the end user’s installation is complete, Robert’s Rules of Order Newly Revised 12th Edition 
can be accessed through the desktop icon or from the list on the Start button menu. 

Opening the Robert’s Rules of Order Newly Revised Infobase 
The installation program automatically creates a Robert’s Rules of Order Newly Revised 12th Edition 
folder on the programs menu, as well as a Robert’s Rules of Order Newly Revised 12th Edition icon on 
your desktop. To open Folio Views, select and open the icon from either location.  

Instructions for Users of Robert’s Rules of Order Newly Revised 11th Edition 
Users who previously purchased and installed the Robert’s Rules of Order Newly Revised 11th Edition CD-
ROM can retain the existing installation and also install the 12th Edition. Each product can then be 
opened and run separately; however, some settings are shared, and the initial menu and toolbar layouts 
will be as in the 11th Edition. If you want to match the appearance of a freshly installed 12th Edition, open 
the 12th Edition and follow the steps below; these changes will also affect the 11th Edition. 

Step 1 To reset the menus, choose File | Customize | Menus | Reset All | OK. 

Step 2 To move the search-related toolbars to the bottom of the window, click inside the border area 
of the Search toolbar (but not on any button) and drag the toolbar to the desired area directly below the 
set of infobase view tabs. Do the same for the toolbar containing the Previous Hit and Next Hit buttons, 
placing it alongside the Search toolbar. 

Step 3 To include all of the standard bottom toolbar buttons, follow the instructions in the 
“Customizing the Toolbars” topic of this guide (pp. 20–21) to add any missing buttons. The default 
bottom toolbar buttons are: Advanced Query, Query Selection, Clear Query, Show/Hide Hit Highlighting, 
and Query Tool (all from the Search category) and Previous Hit, Next Hit, Previous Partition Hit, and Next 
Partition Hit (from the Navigate category). 

Step 4 Continue customizing the toolbars by adding the Show History button (from the Navigate 
category) to the top toolbar. 



QUICK REFERENCE GUIDE – PAGE 8 
 
 

Infobase Views 
A view is a way of looking at information. Depending on what you are doing in an infobase, you may 
need to look at the information in different ways. To facilitate this, Folio Views provides seven different 
views of an infobase. Each view may contain a combination of the window panes shown below. 

 

Changing the View 
To change the view of the infobase: 

Step 1 Identify the Infobase View Tabs on your screen 

 

These tabs are located below the document pane when an infobase is open. 

• There are seven different infobase view tabs: All, Search, Browse, Document, Contents, HitList, 
and Object. 

Step 2 Select the tab corresponding to the view of the infobase you wish to use. 

• Click the appropriate tab to choose a viewing option or press F7 to switch to the next view; 
please experiment to find the view you like best. 

• For detailed information about the different views, please access the Folio Help Infobase by 
pressing F1. 

Step 3 Using the mouse, drag the dividers separating the various panes if you wish to change the 
amount of screen space occupied by each, or drag the program window borders to change the size of 
the entire window. 
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• Lines of text in the Document pane automatically reflow and wrap to fill the pane as the size of 
the pane or the magnification level of the text is changed. For charts and tables that are not 
reflowable, use the left and right arrow keys to scroll through the text or drag the horizontal 
scroll bar at the bottom of the window to move the content left or right within the pane. The 
horizontal scroll bar can be enabled in the menus via Tools | Options | Document | Horizontal 
scroll bar. The setting will be remembered for future sessions of Folio Views. 

Changing the Magnification Level 
To set the zoom level for all text panes, select the View menu and select Zoom. In the Zoom dialog, 
select or type the zoom percentage you wish to use and choose OK. 

To zoom the contents of a particular window pane, first position the mouse pointer over that pane. 
Then hold down the CTRL key on the keyboard while scrolling the mouse wheel up (to increase zoom) or 
down (to decrease zoom). 

Switching Panes 
To change the focus to a different pane using the keyboard, press F8 to move to the next pane 
(clockwise) or SHIFT + F8 to move to the previous pane (counterclockwise). 

Table of Contents 
The Contents pane is a valuable tool for quickly moving around an infobase. An infobase table of 
contents is expandable and collapsible, so you can see as much or as little information as you need. A 
plus sign (+) next to an entry indicates that the entry can be expanded to show subordinate levels.  A 
minus sign (–) indicates that the entry cannot be expanded further, but may be collapsed. 

Every entry in the table of contents is linked automatically to the appropriate section in the Document 
pane. Double-click on an entry (or select it and press ENTER) and you are automatically taken to that 
place in the infobase. 

The Contents pane is displayed when the All, Browse, or Contents views are selected. Clicking inside the 
Contents pane when it is displayed (or pressing CTRL + SHIFT + C) will move the focus to the Contents 
pane so that it is active. 

When first opened, the table of contents displays only the headings at the highest level (Chapter or 
Part). To show or hide lower-level headings: 

• Click a plus sign (+) to expand one level in a branch of the table of contents (or select a heading 
and press the + key on the numeric keypad or SHIFT + + on the main keyboard). 

• Click a minus sign (–) to collapse a branch of the table of contents (or select a heading and press 
the – key). 

• Select a branch heading and use the View menu’s Expand Branch command (or press the * key). 
• Use the View menu’s Expand All or Expand to level… commands. 
• Press a key from 1 through 9 to collapse or expand all branches to the desired depth, where 1 

corresponds to collapsing all. 
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Toolbars 
The toolbars at the top and bottom of the screen allow you to access the most commonly used features 
in Folio Views. The figures below illustrate some of the features explained in this Quick Reference Guide. 

 

 

Viewing Page Numbers 
In this edition of the Robert’s Rules of Order Newly Revised CD-ROM, page number references 
corresponding to the printed books have been hidden so as not to interfere with text flow and 
searching. To display the page numbers, go to Tools | Options and select the Document tab. Then turn 
on Formatting codes and then Jump destinations and choose OK. 

A red line will appear to the left of words. Words with this mark correspond to the first word on a 
page in the printed book. Hover the mouse pointer on the red line to reveal the page number, as 

shown in the figure below. (The same type of mark is also shown to the left of other navigation targets, 
such as paragraph numbers.) 

 

Links  
Hypertext links connect related pieces of information. Links may start from a section of text and end 
anywhere – another section of text, a graphic, a popup note, another infobase, or even a PDF document. 
Links are identified in an infobase by colored text. 
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The Robert’s Rules of Order Newly Revised infobases contain two types of internal hypertext links: 

• Jump links (blue text) will immediately take you from one point in the infobase to another point 
in the infobase. Jump links allow you to “jump to” or access referenced text such as paragraph 
references (“see 56:66”). 

• Popup links (red superscript numbers) will open a separate “popup” window so you can view 
footnotes. 

To activate or follow a link: 

Step 1 Move the mouse cursor over the link so that the mouse cursor becomes a small hand (or use the 
arrow keys on the keyboard to move adjacent to or inside the link text). 

Step 2 Single-click (or press CTRL + ENTER). 

To return from a link: 

Click on the Go Back button (single arrow) at the top of the screen (or press F6) to return to your 
previous location after following a link. 

Jumping to a Paragraph, Page, Section, or Chapter Number 
When you follow a link, you are actually taken to the built-in jump destination associated with that link. 
You can also go directly to such destinations by entering the destination name into the Go To dialog: 

Step 1 Select Go To from the Search menu (or press CTRL + G). The Go To dialog appears with a list of 
possible destinations. The Jump destination Go to: field is already highlighted, with §1 filled in. 

Step 2 Click in the Go to: field to edit the section number, or immediately start typing a different 
destination name to overwrite it. You can also scroll through the destination list. The most common 
destinations are paragraph, page, section, and chapter numbers. For example: 

• §13 
• 12:67 
• p.642 Note: No space between . and page numbers 
• p.t34 
• Chapter V 
• Chart I 
• Table II 

Step 3 Click the Go To button (or press ENTER). The text cursor will now be located at the specified jump 
destination. 

Searching 
Although the extensive indexes in Robert’s Rules of Order Newly Revised and Robert’s Rules of Order 
Newly Revised In Brief have been designed to quickly point you to relevant information throughout each 
work, there will still be times when you want to search the full text for specific words, phrases, or other 
combinations of terms. With the powerful search features built into Folio Views, you can easily search 
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the complete infobase. Basic information on searching is given below. Please see the Help Infobase for 
more detailed information. 

Basic Search Concepts 
To understand how searches work, first note the following: 

• The internal search index used by the Folio Views infobase treats all alphabetic characters as 
lowercase, regardless of how they appear in the text. You don’t need to type anything in 
uppercase when searching. In the Advanced Query dialog (described in these instructions), 
search terms will always be displayed in lowercase. 

• Punctuation marks (commas, periods, hyphens, dashes, colons, slashes, parentheses, etc.) are 
generally ignored (treated as spaces) and cannot be specifically searched for. Limited exceptions 
exist for particular forms within a word or number, such as in 1,253.25, don't, '2/3', and A.M. 
For details, see the “What is a Term” topic in the Help Infobase. Apostrophes are recognized 
within a word (e.g., officer's) but ignored at the end of a word (e.g., officers'). 

• Use surrounding quotation marks to search for terms such as "e-mail", "and/or", "self-
explanatory", and "two-thirds". Inside the quoted phrase, you can type the symbol or 
substitute a space as you prefer. The results will be the same either way and will include all 
forms of the phrase (whether hyphenated or spaced). 

• When searching for phrases or other combinations of terms, the results depend on what can be 
found within each “record” of the infobase text. For example, searching for 
committee* not "of the whole" will find all records that include a word beginning with the 
letters “committee” except where the same record also contains the phrase “of the whole”. 
(Details of the search query syntax are explained in Step 4 below.) A record generally consists of 
one paragraph of text as displayed in the document window, so a single numbered paragraph of 
the text may be spread across several records—for example, when it contains a list or 
subparagraphs. 

• To jump to a specific location by its paragraph, page, section, or chapter number, use the Go To 
feature, as described in this guide, instead of performing a search. 

Performing Searches 
Step 1 (Optional) If you want to limit the search to specific branches of the infobase, select the desired 
branches. 

• To select branches, expand the branches in the Contents pane to display the ones you wish to 
select; then click in the checkbox next to each desired heading. 

• To deselect all currently selected branches, choose Clear All Checks from the View menu. 

Step 2 From the Search menu, choose Advanced Query. 

• You can also access the Advanced Query dialog by pressing F2 on the keyboard or clicking the 
Advanced Query tool (the left binoculars button) on the toolbar at the bottom of the screen. 

Step 3 If specific branches of the infobase have been selected and you wish to limit the search to those 
branches, leave the Checked branches box enabled (checked square). To search the entire infobase, 
make sure the Checked branches box is disabled (blank square). 
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Step 4 Input your search query into the dialog. As you construct a query, the Word list and Records with 
hits areas of the dialog are instantly updated to reflect the words or combinations that will be found 
when the search is performed. To construct the query, use one or more of the following techniques: 

• To recall a search query made earlier in the session (since the current infobase was opened), 
click the Prev button. After Prev is clicked several times, the Next button becomes available to 
recall the more-recent queries. (Note: If you want to always recall the last-performed query as 
soon as the dialog is opened, this can be enabled in the menus via Tools | Options | Query | 
Previous query in query dialog.) 

• Start typing a word to search for. As you type, the dialog attempts to complete the word you are 
typing with a word contained in the infobase. If the word is correct, you can press the ENTER key 
to accept it. 

• Scroll through the word list and select a word you wish to search for. Double-click to enter it into 
the query. 

• Input multiple words, separated by a space between words. A space is equivalent to the and 
operator. The order of the words does not matter when outside of quotation marks. 

• Search for an exact phrase by enclosing the phrase in quotation marks; for example: 
"point of order". Within a quoted phrase, the order and contiguity of words do matter. 
Words within the phrase may contain wildcard operators (as described below). 

• Use the and, or, not, xor (exclusive or) search operators (known as Boolean searching) with 
your search terms to limit or expand the search. Synonyms for these operator names are, 
respectively, the symbols &, |, ^, ~. To search for one of these operator names as a word rather 
than using it as an operator, either use single quotes around it ('and', 'or', 'not', 'xor') or 
include it within a double-quoted phrase. To control the precedence of operators, group items 
using parentheses ( ). 

• Use wildcard operators to match a set of words that fit a pattern: 

Wildcard type Operator Position Example Matches (RONR 12) 
Single Character 
(exactly 1) 

? any ??a sea, via, yea 

Multiple Character 
(0 or more) 

* any *air*n chairman, chairmen, 
chairperson 

Word Form % end apply% apply, applies, 
applied, applying 

Thesaurus Synonym $ end young$ young, 
inexperienced 

Note: The % (Word Form) wildcard operator finds certain variations in grammatical form, 
including changes in tense (has/have/had/having, wait/waits/waiting), number (city/cities, 
president/presidents), and degree (good/better/best, clear/clearer). It does not find different 
noun or pronoun cases (she/her, president/president’s) or derivative forms (abstain/abstention, 
clear/clearly). Depending on the word being sought, you may want to use a term that uses the * 
operator together with, or instead of, a term that uses the % operator. 

• Use proximity operators to specify how close (within how many words or records) terms must 
be to each other. You may include words that contain wildcard operators. Although the terms 
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used with proximity operators must be enclosed in quotes, the search is not limited to exact 
phrases: 

Proximity type Operator Example Matches (RONR 12) 
Ordered word 
proximity 

/ "question of 
privilege"/5 

question of privilege, 
question is one of 
privilege 

Unordered word 
proximity 

@ "dilatory 
motion"@3 

dilatory motion, 
motion is dilatory 

Record proximity 
(unordered) 

# "standard 
descriptive 
rescind"#2 

[8 records with hits] 

• Click on the left bracket button to search in a highlighter, note, popup, field, group, or level. See 
the “Searching a Sub-set of the Infobase” and “Advanced Query Constructions” topics in the 
Help Infobase for more information about such scoped searches. 

Step 5 Choose OK (or press ENTER). 

Step 6 Use the Next Hit and Previous Hit buttons to view hits throughout the infobase. 

• Use the Next Hit button (the double arrows point to the right) on the bottom toolbar (or press 
F4) to move forward one hit at a time. 

• Use the Previous Hit button (the double arrows point to the left) on the bottom toolbar (or 
press SHIFT + F4) to move backwards one hit at a time. 

Step 7 To begin a new search, choose Clear Query from the Search menu, and repeat steps (1) through 
(6) above. 

• You can also click the Clear Query button (the binoculars crossed out with an “X”) on the 
bottom toolbar; or 

• You can use the Go Back button (single arrow) on the top toolbar (or press F6) to return to the 
point in the infobase where you initiated the search. 

Note: For detailed information on searching, please open the Advanced Query dialog 
(as explained above) and click on the Help button. The Help Infobase will open 

automatically to the section on searching. 

Using the Search Feature and the Table of Contents Feature Together 
After you have performed a search, you can click on the Browse document viewing tab or the Contents 
document viewing tab at the bottom of the screen to see the number of search hits in the table of 
contents pane. 

This feature must be enabled in the menus via Tools | Options | Contents | Query results. The setting 
will be remembered for future sessions of Folio Views. 
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As shown in the figure below, the number of search hits under each heading is displayed to the left of 
that heading. In this example, the figure illustrates a search for the phrase "out of order" (containing 61 
total hits). Branches that are collapsed show the total number of hits within the branch; expand the 
branch to show the hits at lower levels. Double-click on any heading to jump to the corresponding 
location in the Document pane, where the search hits will be highlighted. 

Query Templates 
A query template is a custom-designed search screen that allows you to search for specific pieces of 
information in an infobase. Query templates are designed to simplify the search process by hiding some 
of the complexity of the Folio Views search syntax. 

Using the Robert’s Rules of Order Newly Revised Query Templates 
The Robert’s Rules of Order Newly Revised infobase contains two query templates: 

• The Chapter Searches template allows you to search for information in a specific chapter of the 
publication. 

• The Search Index Only template allows you to search the index. 

To use any template: 

Step 1 Select the Search menu. 

• Available query templates appear at the bottom of the menu. 

Step 2 Select the query template you wish to use. 
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Note: You can also activate a query template directly using a keyboard shortcut. 
Press CTRL + 1 for the Chapter Searches template or CTRL + 2 for the Search Index 

Only template. 

Step 3 Follow the instructions on the query template dialog and type the word or words you wish to 
find. 

Step 4 Choose OK to view the search results. 

Printing 
Printing Small Portions of Text 
To print a portion of Robert’s Rules of Order Newly Revised: 

Step 1 Select the records you wish to print: 

• Using the mouse, move your cursor to the beginning of the text you wish to print, press the left 
mouse button, and (without releasing the mouse button) move the cursor to the end of the text 
you wish to print. 

• Using the keyboard, scroll to the beginning of the text you wish to print, press the SHIFT key, 
and (without releasing the SHIFT key) use the arrow keys to move. 

Step 2 Choose Print from the File menu (or press CTRL + P). 

Step 3 Choose OK or press ENTER. 

• The selected text will be printed. 

Printing Larger Portions of Text 
To print a larger portion of Robert’s Rules of Order Newly Revised (such as a chapter or section of the 
publication): 

Step 1 Choose Print from the File menu (or press CTRL + P). 

Step 2 Select the Section option on the Print Document tab. 

Step 3 Choose the item (chapter, section, etc.) you wish to print. 

• Using the table of contents that appears in the Print Document tab, expand or collapse the 
headings to find the specific item you wish to print. 

• Select the item by clicking on the checkbox. 

Step 4 Choose OK or press ENTER. 

• The selected text will be printed. 
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Copying and Pasting 
With Folio Views, you can use the standard Microsoft Windows clipboard feature to copy and paste 
small portions of text to your word processor for ready reference. To use the standard Windows 
clipboard functions: 

Step 1 Select the information you wish to copy. 

• Using the mouse, move your cursor to the beginning of the text you wish to print, press the left 
mouse button, and (without releasing the mouse button) move the cursor to the end of the text 
you wish to copy. 

• Using the keyboard, scroll to the beginning of the text you wish to print, press the SHIFT key, 
and (without releasing the SHIFT key) use the arrow keys to move. 

Step 2 Choose the Copy feature from the Edit menu. 

• The Copy feature makes a copy of the information in the infobase and places it in the clipboard. 
• You can also press CTRL + C on your keyboard to copy text. 
• You can also use the right mouse button menu to copy highlighted material. 

Step 3 Place the insertion point at the location in your word processor where you wish to paste the 
text. 

Step 4 Use the Paste feature in your word processor. 

• You can also press CTRL + V on your keyboard to paste the copied material. 
• You can also use the right mouse button menu to paste the copied material. 

Shadow Files 
The next sections of this Quick Reference Guide deal with Folio’s personalization features. These 
features (notes, bookmarks, and highlighters) allow you to add your own unique comments, mark your 
place, or highlight information in the Robert’s Rules of Order Newly Revised infobase. These features 
are described in further detail on the following pages. Before you can use these personalization 
features, however, you must first create a “Folio shadow file.” 

A shadow file is a unique Folio Views feature that allows you to store and retain the personal changes 
that you make to an infobase. Much like an overlay or transparency allows you to mark up or annotate 
information without changing an original printed document, a shadow file allows you to change 
information in a personal view of an infobase without affecting the master infobase. When you create a 
shadow file, you create an overlay for an infobase. When you add notes, highlighters, or bookmarks to 
the shadow file, they do not appear in the original infobase (the master). Any change that you make to 
the shadow file appears only in the shadow file. 

Creating a Shadow File 
To create a new shadow file: 

Step 1 Open the Robert’s Rules of Order Newly Revised infobase. 

Step 2 Choose New from the File menu. 
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Step 3 Select Folio Shadow File from the File type list. 

Step 4 Click in the File name field and enter a name for the shadow file. 

• The name may be the same as the infobase, provided that you use the .SDW extension. 
• If necessary, specify the drive or folder where the new file should be created. 

Step 5 Choose OK. 

Opening a Shadow File 
To open an existing shadow file: 

Step 1 Choose Open from the File menu. 

Step 2 Locate the shadow file you wish to open. 

• Shadow files have a .SDW extension. 

Step 3 Double-click on the file to open it. 

Highlighters 
Highlighters are used in an infobase in a similar way that highlighter pens are used on paper-based 
books and articles. However, unlike highlighted text that must be searched by turning pages, the 
highlighters you create in Folio Views can be searched separately from the rest of the infobase. You can 
search for words contained in a particular highlighter or you can search for all the places where a 
particular highlighter was applied. In addition, you can customize highlighters by adding colors and 
changing character attributes, such as font and bold. (Before using highlighters, you must create a 
shadow file, as described above.) 

Creating and Applying Highlighters 
Step 1 Select a block of text. 

Step 2 Select the small Highlighter button on the right end of the toolbar, or press CTRL + H. (This is 
different from the larger Highlighters tool. For more information on using the Highlighters tool, see the 
Help Infobase.) 

Step 3 Select New and create a name for the highlighter. 

Step 4 Choose Format to change the appearance of the highlighter. 

• You can create unique attributes for your highlighter. For example, you can change the font, the 
point size, the foreground color, or the background color. Choose OK to close the Highlighter 
Format dialog and apply the formatting attributes to the highlighter. 

Step 5 Choose Apply to apply the highlighter to the text. 
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Notes 
Notes are used in an infobase in the same way that “sticky” notes are used to mark written materials. 
Notes can contain comments, questions, graphics, or objects. A yellow “sticky” note icon at the 
beginning of a record or paragraph indicates that a note is attached. Note boxes can be sized and placed 
anywhere on the document window. When you save a note, and reopen it later, the note will open in 
the exact size and position in which it was saved. (Before creating notes, you must create a shadow file, 
as described above.) 

Creating and Accessing Notes 
Step 1 Move the cursor to the record where you want to attach the note. Each paragraph or table cell 
can contain one note. 

Step 2 Select the Note button on the toolbar (or press CTRL + N). 

Step 3 Type the text you wish to include in the note. Size the note window to your desired size. 

Step 4 When you are finished, close the note by clicking the X or pressing ESC. 

Step 5 Choose Yes to save the note or No not to save it. 

Step 6 When you want to view or edit the note again, click on the note icon (or place the insertion 
point in the record containing the note and press CTRL + N) to open the note. 

The notes you create can be printed as end notes when you use the printing feature. 
Choose Options from the Tools menu, select the Print tab, and click on the Notes 

checkbox to turn this feature on or off. 

Deleting Notes 
To remove a note: 

Step 1 Place the insertion point in the paragraph or table cell containing the note. 

• Select multiple paragraphs if you wish to remove several notes at once. 

Step 2 Choose Remove Note from the Tools menu (or press CTRL + SHIFT + N). 

Bookmarks 
Bookmarks in Folio Views serve the same function as regular bookmarks: you use them to mark your 
place. When you no longer need the bookmark, you may remove it. You can have an unlimited number 
of bookmarks in each infobase. (Before creating bookmarks, you must create a shadow file, as described 
above.) 

Creating and Accessing Bookmarks 
Step 1 Move the cursor to a location in the infobase you wish to mark. 

Step 2 Select the Bookmark button on the toolbar (or press CTRL + M). 
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Step 3 Give the bookmark a meaningful name and choose Set. 

Step 4 When you need to access the location, click the Bookmark tool and double-click the name of the 
bookmark you wish to use. 

Step 5 To delete a bookmark, select the Bookmark button, choose the name of the bookmark you wish 
to remove, and select Delete. 

Customizing the Toolbars 
Folio Views allows users to customize the toolbars to suit their needs. Under View, choose Toolbars. 
Users will see the standard toolbars listed: Search, Personalize, Navigation, and Standard are the default 
toolbars and appear checkmarked. Format, Table, and Link appear unchecked. Some features on 
toolbars will not work unless a user has first created a shadow file, and some features will appear grayed 
out if you do not have edit privileges for the infobase. 

Format — Contains often used formatting options, including the style list, font list, character formats, 
and paragraph justification. 

Link — Contains all of the link options for creating or removing links. 

Navigation — Contains common actions to help you move around the infobase, including Go Back, Go 
Forward, Show History, Go To, and Synchronize Contents. 

Personalize — Contains classic personalization tools, including highlighters (both creation and 
application), Bookmark, and Note. 

Search — Contains the most common search tools, including Advanced Query, Query Selection, Clear 
Query, Show/Hide Hit Highlighting, Query Tool, Previous Hit, Next Hit, Previous Partition Hit, and Next 
Partition Hit. 

Standard — Contains standard file management actions, including New, Open, Save, Explore Infobases, 
Find Infobases, and Print. 

Table — Contains table creation and formatting options, such as Insert Table, Table Format, Cell Format, 
and Merge Cells. 

To customize your toolbar buttons, click Customize from the right-hand listing. Under the Toolbars tab, 
you will find a listing of the categories and the tool icons associated with each category. To customize an 
existing toolbar by adding a tool, drag a tool from the dialog and drop it with the mouse pointer to an 
existing toolbar in the main program window. If you drag the tool off the dialog but do not attach it to 
an existing toolbar, a new toolbar is created. New toolbars will appear under the Toolbars list with the 
standard toolbars. 

• Click on a tool in the dialog for a description of the tool. 
• Drag tools off a toolbar in the main program window to remove them from the toolbar. 
• Drag tools from one location to another on a toolbar in the main program window to rearrange 

the tools. 
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Recommended Custom Tools 
There are several tools that may be most helpful for users to considering adding to a toolbar for quick 
reference: 

Query Template 1 and Query Template 2 icons – found under the Search category, added to the Search 
toolbar at the bottom of the screen. Query Template 1 is used for the Chapter search, while Query 
Template 2 is used for the Index search. 

 

 

Query Templates 

Adding Copy, Paste, and Cut to the standard toolbar at the top of the screen: 

 

 

Copy  

Paste 

Cut 

 

In addition, users can remove icons on the toolbar that are not needed when under Views, Toolbars, 
Customize, by dragging unneeded icons off the toolbar. Changes to toolbars that users make do not 
affect others’ use of the software.  
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To order additional copies of Robert’s Rules of Order Newly Revised on CD-ROM or additional network 
user licenses, please contact us at 800-445-5588 or at sales@amlegal.com. 
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